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Вступ. Європейська інтеграція відкриває нові можливості для освіти України, 

але при цьому перед нею постають й нові виклики, зокрема, в частині забезпечення на-
вчального процесу сучасним програмним забезпеченням (ПЗ), яке повинно мати лега-
льне походження, бути ліцензованим або відкритим. 

Аналіз показує, що більшість ПЗ в сфері освіти України базується на рішеннях 
Microsoft (ОСWindows, MSOfficeй все, що з ними пов’язано) та у своїй більшості, на-
жаль, на має ліцензій і є контрафактним. І причина не тільки в тому, що Україна бідна, 
а ще й в тому, що не розглядаються альтернативи такому стану речей. 

Одним з шляхів змінення ситуації, безумовно, є офіційне придбання ліцензій, па-
кетів ПЗ, але, наприклад, роздрібна ціна одного пакету Windows 7 коштує 2000÷8000 грн.; 
MSOffice 7/10/13 – 2000÷7500 грн.; а потрібні ще графічні редактори, системи безпеки, 
інформаційні системи різних напрямків. Зрозуміло, якщо задача буде розв’язуватися на 
державному рівні, то ціни будуть значно нижчими, але це все одно – багатомільйонні 
суми. 

З іншого боку вирішення проблеми можна забезпечити шляхом переходу з плат-
ного ПЗ на відкриті системи, звісно у тих випадках, де це можливо [1]. 

Така альтернатива є, наприклад, при викладанні дисциплін загальних інформа-
тивних напрямків, зокрема, при навчанні студентів некомп’ютерних спеціальностей. 
Сюди можна віднести перехід на сучасні програмні платформи відкритого типу 
(Freeware): операційні системи, офісні пакети, програмне забезпечення інженерно-
наукових розрахунків, середовища програмування з відкритим програмним кодом. 

Постановка задачі. Розробити загальну структуру IT дисциплін, яка має включа-
ти теоретичне та лабораторно-практичне забезпечення з використанням відкритого ПЗ. 

Результати роботи. Аналіз змісту дисциплін IT напрямку, які викладаються в 
ДДТУ [2], показує, що в якості програмного середовища використовується ОС 
WindowsXP (підтримка якої вже давно припинена Microsoft), офісні пакети  
MSOffice 2000/2007 (додатки: MSWord, MSExcel, СУБД MSAccess), пакети  інженерно-
наукових розрахунків MathSoft/PTCMathCad 12/14/15, мови й середовища програму-
вання BorlandPascal/Delphi, BorlandC++, MSVisualBasic/VisualBasicforApplication 
(VBA). 

З метою альтернативного забезпечення навчального процесу пропонується стру-
ктура, яка включає відкрите ПЗ й складається з наступних сегментів. 

1. Операційна система. 
В якості операційної системи доцільним є використання Ubuntu Linux [3] – це 

повноцінна настільна операційна система Linux, яка вільно поширюється та забезпечу-
ється підтримкою з боку Спільноти Ubuntu і професіоналів. Ubuntu спирається на такі 
ідеї (Ubuntu Manifesto): програмне забезпечення має бути безкоштовним, програмні за-
соби повинні бути придатними для використання людьми їх рідною мовою і повинні 
нехтувати будь-якими їх фізичними вадами, люди повинні бути вільні у налаштуванні і 
зміні свого програмного забезпечення будь-яким зручним для них способом. 

Якщо ж постає питання забезпечення найбільших можливостей для вводу–
виводу, використання плагінів для браузерів, медіа–кодеків, підтримки DVD, Java та 
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інших компонентів, то може бути запропонований дистрибутив LinuxMint (на базі 
Ubuntu Linux) [4]. 

2. Офісні пакети. 
Найбільш відомими з відкритих офісних пакетів є OpenOffice та LibreOffice, які 

є повноцінною заміною Microsoft Office. До їх складу входять текстовий та табличний 
процесори, редактори векторних зображень, презентацій, математичних формул. 

У нашому випадку перевага віддається пакету LibreOffice, тому що він повністю 
сумісний з 32/64 бітними системами, підтримує українську, англійську мови (та ще 
близько 40 інших), й головне є кросплатформенним продуктом (підтримується для 
GNU/Linux, Microsoft Windows та MacOSX). 

До складу LibreOffice входять наступні додатки, які за функціоналом нічим не 
поступаються відповідним додаткам Microsoft Office, підтримують всі його формати: 
Текстовий процесор Writer – аналог MS Word; Табличний процесор Calc – аналог MS 
Excel; База даних Base – аналог MS Access; Презентація Impress – аналог PowerPoint; 
графічний редактор Draw – потужний редактор опрацювання растрової та векторної 
графіки (аналогу Office не має); редактор формул Math – аналог MS Equation. 

Підтвердженням можливості повної взаємної заміни одного ПЗ іншим є приклад 
виконання завдання [5, с.46] спочатку в середовищі MSExcel (2010): 

 

 
 
А потім таке саме завдання виконується в середовищі LibreOffice Calc (4.3.5.2): 
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3. Програмне забезпечення інженерно-наукових задач. 
Висока вартість систем PTC MathCad майже не дає інших альтернатив, ніж ви-

користання безкоштовних математичних пакетів-аналогів. Серед них такі ПЗ, як: сис-
тема комп’ютерної алгебри Maxima [6], Octave – кросплатформенний пакет чисельної 
математики, аналог MathLab [7], Scilab – потужний відкритий пакет для наукових роз-
рахунків [8], а також математичний пакет SMath Studio [9], який за своїм інтерфей-
сом та функціоналом більше всього схожий на MathCad (крім того існує збірка 
SMath Studio+Maxima, яка робить з неї майже повноцінну заміну MathCad в учбовому 
процесі). 

Саме на останньому варіанті ПЗ можна зупинитися при вивченні розділів, що 
пов’язані з використанням математичних пакетів при розв’язанні інженерних задач. 

4. Мови й середовища програмування. 
В цій частині є також необхідні відкриті рішення, які можна використати під час 

переходу зі застарілих або платних версій середовищ та мов розробки програм. В час-
тині учбово-методичного забезпечення, що зорієнтовано на Borland Pascal/Delphi доці-
льним видається перехід до середовища Lazarus/FreePascal [10], Borland (С/C++) – 
доEclipse IDE for C/C++ [11], Visual Basic – до FreeBASIC [12], VBA – до аналогу IDE 
StarBasic [13]. І тут не виникає проблем переходу. Наприклад, для завдання [14, с.63] 
записано текст програми: 
1) в середовищі VBA (Excel 2010) 
Private Sub cmdCalculate_Click() 
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x = Val(txtArg1.Text) 
a = Val(txtArg2.Text) 

If x < 1 Then y = 1.5 * (Cos(x)) ^ 2 - a ^ 3 
If x = 1 Then y = (x - 2) ^ 2 + 6 * a 
If (x > 1 And a >= -3) Then y = 3 * Tan(x) + Sqr(3 + a) 

txtResult.Text = "y=" + Str(y) 
If (x > 1 And a < -3) Then txtResult.Text = "Failed data a" 

End Sub 
Private Sub cmdExit_Click() 

End 
End Sub 

2) в середовищі LibreOffice Basic(4.3.5.2) 
Dim Dialog_3 As Object 

Sub MyProc 
  DialogLibraries.LoadLibrary("Standard") 
  Dialog_3 = CreateUnoDialog(DialogLibraries.Standard.MyForm_3) 
  Dialog_3.execute() 

End Sub 
Sub Cmdcalculate_3 

TextField = Dialog_3.getControl("TextField3_1") 
x= Val(TextField.Text) 

TextField = Dialog_3.getControl("TextField3_2") 
a= Val(TextField.Text) 

TextField = Dialog_3.getControl("TextField3_3") 
If x < 1 Then y = 1.5 * (Cos(x)) ^ 2 - a ^ 3 
If x = 1 Then y = (x - 2) ^ 2 + 6 * a 
If (x > 1 And a >= -3) Then y = 3 * Tan(x) + Sqr(3 + a) 

TextField.Text = "y=" + Str(y) 
If (x > 1 And a < -3) Then TextField.Text = "Failed data a" 

End Sub 
Sub Cmdexit_3 

  Dialog_3.endExecute() 
End Sub 

Створені екранні форми: 
1) в середовищі VBA (Excel 2010)      2) в середовищі LibreOffice Basic (4.3.5.2) 
 

 
 
Підсумок: для жодного з сегментів не виникає проблем переходу на відкриті си-

стеми. Тому пропонується наступна структура IT дисциплін: 
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Висновки. У роботі запропоновано структура викладання IT дисциплін для сту-
дентів некомп’ютерних напрямків, яка повністю базується на відкритому, безкоштов-
ному програмному забезпеченні. При цьому якість та можливості перелічених програ-
мних продуктів жодним чином не погіршують звичних можливостей наявного забезпе-
чення (на базі ОС Windows). 

Інформативна складова не суперечить існуючим навчальним програмам, бо суть 
залишається та сама, а міняється підхід, програмна платформа та інструментарій 
розв’язання задач, що підтверджується наведеними прикладами. 

Також слід пам’ятати, що такий перехід виключає можливі майбутні закиди з при-
воду нелегітимності систем, що використовуються, в тому числі й в навчальному процесі. 
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ОБУЧЕНИЕ НАЧАЛЬНЫМ НАВЫКАМ  

ТЕСТИРОВАНИЯ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ 
 

Введение. Тестирование программного обеспечения (ПО) представляет собой 
исследование, проведенное с целью обеспечения заинтересованных сторон (заказчика и 
разработчика) объективной информацией о качестве продукта или услуги [1-5]. Другой 
целью тестирования ПО может быть оценка рисков реализации и внедрения тестируе-
мого программного продукта. 

Методы тестирования (испытаний) включают в себя процесс выполнения про-
граммы или приложения с целью найти ошибки (или другие дефекты) в ПО, а также 
оценить одно или несколько его свойств, например: 

– отвечает ли требованиям заказчика; 
– правильно ли реагирует на все виды входных данных; 
– выполняет ли свои функции в пределах допустимого времени; 
– достаточно ли удобно; 
– достигает ли результата, требуемого заинтересованными сторонами. 
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Поскольку число возможных тестов для даже самых простых программных ком-
понентов практически бесконечно, все методы тестирования ПО используют некото-
рую стратегию выбора тестов для имеющегося времени и ресурсов. Процесс тестиро-
вания является итерактивным, т.к. когда ошибка будет исправлена, она может осветить 
и другие, более глубокие ошибки, или может даже создать новые. 

Тестирование ПО представляет собой важный элемент производственного цикла 
разработки программных продуктов, но до сих пор недостаточно представлен в процес-
се подготовки специалистов в области программной инженерии. 

Постановка задачи. Учитывая, что профессия тестировщика стала одной из са-
мых востребованных на рынке IT, очень важно при подготовке специалистов уделить 
достаточное внимание этому сегменту разработки программных продуктов. Достаточно 
большая часть выпускников-программистов свою первую работу выполняют в качестве 
тестировщика ПО, и поэтому работодатель заинтересован в специалистах с имеющимся 
багажом конкретных практических навыков. 

Поиску решений этой проблемы посвящена данная работа. 
Результаты роботы. Что ожидает работодатель от начинающего тестировщика? 

Самое главное, чтобы тестировщик не только нашел дефект, но и правильно его описал. 
Это базовый навык, т.к. обычно начинающий тестировщик работает с уже разработанным 
наставником тест-планом и ему нужно лишь, отталкиваясь от него, отыскивать ошибки 
ПО. Здесь неважно, как дефект был найден. Важно, чтобы он был однозначно описан и 
программист смог его воспроизвести с минимальными дополнительными вопросами. 

Используемый подход основывается на движении от практики к теории. Его цель 
– дать студентам на себе прочувствовать, что же такое неправильно описанный дефект. 

На первом этапе студенты должны протестировать без спецификации конкрет-
ное ПО и сделать отчет о найденных дефектах, при этом не требуется никаких уточне-
ний о понятии «дефект», «отчет о дефектах» и т.п. Для проверки квалификации тести-
ровщика предлагается использовать приложение ListBoxer (рис.1) [6], которое является 
в определенном смысле стандартом в этой сфере. Это приложение представляет собой 
программу, в которой реализован простейший, но достаточно всеохватывающий функ-
ционал с большим количеством ошибок, которые сделаны преднамеренно. 

 

 
Рисунок 1 – Окно приложения ListBoxer 
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Суть приложения в том, что пользователь создает некий список из строк, кото-
рые могут состоять из символов латиницы и цифр, и проводит с этим списком различ-
ные манипуляции: 

– добавляет новые элементы согласно правилам валидации; 
– фильтрует по диапазону; 
– упорядочивает по возрастанию/убыванию; 
– показывает только латиницу или только цифры; 
– сохраняет в файл или загружает из файла. 

В виду того, что никаких требований к приложению ListBoxer нет, то предпола-
гается, что тестирование опирается на здравый смыл тестировщика и на информацию 
из раздела «Помощь». Применяемая стратегия тестирования – «черный ящик», т.к. дос-
тупа к коду не имеется. 

Несмотря на то, что приложение на вид простое, оно позволяет проработать та-
кие подходы к функциональному тестированию, как: 

– классы эквивалентности; 
– классы граничных точек (предпочтительно вынести их в отдельный класс); 
– попарное тестирование; 
– таблица решений; 
– сценарии пользователя. 

У приложения есть инсталлятор, поэтому большим участком работ является тес-
тирование инсталлятора. Отдельное внимание можно уделить тестированию удобства 
пользования (usability) и тестированию документации (помощи). 

Ориентировочной цифрой приличного результата является нахождение тести-
ровщиком 50 дефектов. Лучший студенческий результат показал 32 дефекта. 

Почему же так важно правильно описать дефект? Дело в том, что стоимость не-
правильно описанной проблемы очень велика. Типичным сценарием в этом случае яв-
ляется «перекидывание» дефекта между программистом и тестировщиком. Квалифици-
рованный программист будет отправлять назад дефект до тех пор, пока его содержимое 
не станет однозначно воспроизводить проблему. 

Не стоит ожидать от студентов отличных результатов по тестированию, а тем 
более описанию дефектов в первый раз. Предлагается выносить на всеобщее обсужде-
ние каждый отчет, чтобы все остальные могли представить себя на месте программи-
ста, получившего ошибку. 

Главные моменты, которые нужно донести о дефекте. 
1. Дефект – это несоответствие фактического поведения ПО ожидаемому. Если фак-

тический результат не равен ожидаемому – это дефект. В случае ListBoxer (на самом 
деле, это характерно и для многих коммерческих продуктов) ожидаемый результат бе-
рется из здравого смысла в широком понимании (сюда же добавляется опыт пользова-
теля, стандарты в этой сфере и т.п.). 

2. Дефект должен однозначно воспроизводиться. Должно быть приведено мини-
мальное количество шагов, которое позволяет программисту повторить то, что видит 
тестировщик. 

3. Версия тестируемого ПО. Дефект всегда обнаруживается в какой-то конкретной 
версии программы и исправляется в какой-то другой конкретной версии. Если у при-
ложения нет версии – это дефект, который не позволяет тестировать, т.к. невозможно 
обеспечить учет и контроль ошибок. 

4. Приоритет. Все дефекты могут быть как очень важными, так и совсем незначи-
тельными. Это зависит от того, какие требования выставлены к программному продук-
ту. В отдельных случаях и опечатка может быть критическим дефектом (например, 
опечатка в основном номере телефона онлайн-магазина). 
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5. Автор дефекта. Это нужно, прежде всего, для взаимодействия в команде. 
6. Идентификатор. Все дефекты должны иметь уникальные идентификаторы. Прак-

тически всегда для учета дефектов используются специальные системы, которые авто-
матически присваивают идентификатор. 

Далее отметим типичные ошибки, которые совершают начинающие тестиров-
щики при использовании ListBoxer. 

1. Не указывается версия ListBoxer. Ни один студент не указал версию при оформ-
лении дефектов в первый раз. 

2. Не используется понятие «фактического результата» и «ожидаемого результата» 
(в привычной английской терминологии actual, expected). Вместо этого используют 
слова и выражения «неправильно», «неверно». Например, у каждого второго студента 
был дефект «неправильная сортировка или вводим данные, сортирует неправильно». 
Без подробностей, что такое неправильная сортировка, как будто у всех одинаковое 
представление. Нужно отметить, что этой проблеме (неожиданно для самих студентов) 
уделено чрезвычайно много времени, поскольку мнения разделились, что же такое «не-
правильная сортировка», если учитывать, что в строках присутствуют числа. Этот де-
фект – замечательный пример для того, чтобы продемонстрировать, как важно тести-
ровщику довести однозначно программисту проблему, после чего можно перевести 
диалог в плоскость «это не дефект, это так и должно быть или же да, это дефект». 
Главное, чтобы программист правильно понял, на какую ситуацию ему указывают. 

Другой случай из этого же ряда – при вводе запрещенных символов компьютер 
«пищит». Можно сказать, что фактический результат понятен. А вот какой же ожидае-
мый? Компьютер выдает сообщение с предупреждением о несоответствии формату, 
«пищит» как-то иначе и т.д.? 

3. Не используются конкретные примеры вводимых данных и конкретного ожидае-
мого результата для них. Так, например, описание «неправильная сортировка» нужно 
разворачивать в подобный вид: 

– запустить ListBoxer.exe(v.1.98); 
– выбрать режим Numeric; 
– ввести в текстовое поле: 27, 10, 300, 80; 
– выбрать сортировку Ascending. 

Фактический результат: 10, 27, 300, 80. 
Ожидаемый результат: 10, 27, 80, 300. 

4. Не используются скриншоты (например, рис.2). Конечно, необходимым условием 
описания дефекта является наличие всех шагов для воспроизведения. Скриншот не яв-
ляется обязательным по определению, но с точки зрения человеческого фактора нали-
чие правильно сделанного скриншота существенно увеличивает скорость понимания 
проблемы. Особенно это касается дефектов, которые связаны с элементами интерфейса, 
такими как опечатки, «съехавшая» верстка в веб-проектах, элементами интерфейса, не 
соответствующим спроектированному дизайну и т.д. 

5. Пропускается шаг с описанием, что именно нужно запустить, и сразу выполняет-
ся переход к месту, которое не работает. Во-первых, в этом случае не понятно, что за-
пускается – инсталлятор или само приложение (это становится понятным дальше из 
контекста), во-вторых, вместе с этим шагом часто пропускается и указание версии, в 
которой найдена проблема. 

6. Не пишется однотипно «фактический» и «ожидаемый» результат. Например, вме-
сто такого описания: 

Фактический результат: в выпадающем списке «Range» имеется пустое поле. 
Ожидаемый результат: отсутствие пустого поля. 

лучше воспринимается, когда ожидаемый результат будет описан в такой же последо-
вательности, как и фактический: 
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Фактический результат: В выпадающем списке «Range» имеется пустое поле. 
Ожидаемый результат: В выпадающем списке «Range» нет пустого поля. 

7. Не присваивается идентификатор дефекту. Важно обратить на это внимание, но 
при этом следить, чтобы при переносе дефектов из простого отчета в систему учета за-
дач в названии проблемы не писали идентификаторы, т.к. они будут присваиваться сис-
темой автоматически. 

8. В фактическом результате описывается и ожидаемый. Здесь типичное слово – 
«вместо», например: 

Фактический результат: В пункте меню написано Edjt вместо Edit. 
Ожидаемый результат: Edit. 

Нужно так: 
Фактический результат: В пункте меню написано Edjt. 
Ожидаемый результат: В пункте меню написано Edit. 

9. Используются лишние шаги. Характерным случаем является ошибка чтения из 
файла. В этом случае вместо того, чтобы приложить файл, чтение которого приводит к 
ошибке, тестировщик предлагает сначала воспроизвести сценарий получения данного 
файла, его сохранения и только потом открытия. 

Пример с лишними шагами. 
Запустить ListBoxer.exe (v.198); 
1. Добавить в список значения 12, 45, doc, tatata. 
2. С помощью пункта меню File-Save сохранить файл. 
3. Открыть сохраненный файл. 
Фактический результат: В списке отобразились: 45, doc, tatata (утерян первый 

элемент из файла). 
Ожидаемый результат: В списке отобразились 12, 45, doc, tatata. 

Нужно так: 
1. Запустить ListBoxer.exe (v.198);  
2. С помощью пункта меню File-> Open выбрать файл nofirst.lbx (приложен к 

дефекту). 
Фактический результат: В списке отобразились: 45, doc, tatata (утерян первый 

элемент из файла). 

Рисунок 2. – Пример скриншота ListBoxer и его оформления 
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Ожидаемый результат: В списке отобразились 12, 45, doc, tatata. 
Помимо того, что первый вариант заставляет программиста делать лишние ша-

ги, так он (что более важно) вводит в заблуждение, что на дефект влияет именно после-
довательность «создать данные->сохранить файл->открыть файл» в то время, как де-
фект лежит только в плоскости «открыть файл». 

10. В одном дефекте описывается несколько похожих случаев. Таким примером 
служит ситуация с пунктами меню Copy, Cut. Действительно, ожидаемое поведение для 
стандартных функций Copy и Cut похоже, и если дефект выглядит однотипно, то ка-
жется допустимым описать все одним дефектом. Но это в корне неверно, т.к. непосред-
ственно в коде может быть два разных участка, в которые нужно внести изменения. В 
этой ситуации нужно заводить столько дефектов, сколько функций не работает соглас-
но спецификации, а в самих дефектах будет полезным указать примечание, в котором 
указать, с какой подобной ситуацией столкнулся тестировщик. 

Пример некорректного описания дефекта: 
Фактический результат: Элементы меню Edit->Cut, Edit->Copy недоступны. 
Ожидаемый результат: Edit->Cut и Edit->Copy доступны   

Нужно писать так: 
Фактический результат: Элемент меню Edit->Cut недоступен. 
Ожидаемый результат: Элемент меню Edit->Cut доступен. 

Примечание: Похожая проблема с элементом меню Edit->Copy (дефект № – ссылка 
на дефект). 

Выводы. Таким образом, были представлены 10 наиболее распространенных 
ошибок в описании дефектов. Моделирование рабочей ситуации, когда начинающий 
тестировщик идет по разработанному тест-плану и заполняет сам дефекты, позволило 
каждому студенту проанализировать качество найденных дефектов и понять на собст-
венном опыте, насколько усложняют рабочее взаимодействие ошибки на начальном 
уровне. Кроме этого, такое погружение в практику на первых занятиях стимулирует 
студентов более вдумчиво подходить к последующей теоретической части проектиро-
вания тестовых сценариев. В целом, использование рассмотренной методики обучения 
студентов-программистов при изучении дисциплины «Качество программного обеспе-
чения и тестирование» позволило привить им начальные навыки успешного тестирова-
ния ПО, что даст возможность выпускникам повысить шансы на успешное трудоуст-
ройство и дальнейший карьерный рост. 
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УДК 378 ЛЕЩЕНКО О.П., старший викладач 
 

Дніпродзержинський державний технічний університет 
 

ЗАСТОСУВАННЯ ІНФОРМАЦІЙНИХ ТЕХНОЛОГІЙ  
У ВИКЛАДАННІ ІНОЗЕМНОЇ МОВИ СТУДЕНТАМ  

У ТЕХНІЧНОМУ ВИЩОМУ НАВЧАЛЬНОМУ ЗАКЛАДІ 
 
Вступ. Оцінюючи останні тенденції еволюції сучасного суспільства, можна зро-

бити висновок, що воно є інформаційним. Основою соціально-економічного розвитку 
даного суспільства є не матеріальне виробництво, а виробництво інформації та знань. 
Економічний і технологічний розвиток будь-якої країни, добробут її населення пропор-
ційно залежить від рівня освіти, знань, навичок, умінь і кваліфікації активної частини 
населення даної держави. Наявність високої кваліфікації робить людей більш стійкими 
до можливих змін типу і профілю роботи, дає їм можливість швидше працевлаштува-
тися у випадку втрати роботи, робить їх більш гнучкими до зміни ситуації на ринку 
праці і в економіці країни загалом. Розвиток високих технологій у все більших і біль-
ших масштабах підвищує попит на інтелектуальність в освіті людей. Це кардинально 
змінює інституційний статус системи освіти в суспільстві. Освіта стає інструментом 
капіталу у боротьбі за ринок [1]. 

Постановка задачі. Сучасному суспільству потрібна якісна освіта на масовому 
рівні, яка буде в змозі задовольнити вимоги як споживача, так і виробника матеріаль-
них цінностей і духовних благ. Розвиток інформаційних технологій звернув увагу лю-
дей на проблему модернізації системи освіти. У зв’язку з цим у суспільстві з’явилась 
ідея дистанційної освіти. Актуальність такої освітньої концепції пов’язана з появою та-
кого глобального явища як Інтернет, що охоплює широкі шари суспільства і стає одним 
з найпотужніших і важливіших факторів його розвитку. Така модернізація системи 
освіти набуває особливого значення в Україні. 

Результати роботи. Загальновідомо, що традиційною формою організації на-
вчального процесу для студентів як денного, так і заочного відділення є сукупність пе-
вної кількості лекційних і практичних занять для вивчення кожної окремої дисципліни, 
але для студентів заочного відділення значно більша кількість годин виділяється для 
самостійної роботи. Керуючись власним досвідом викладання такої дисципліни, як 
«Методика викладання іноземної мови з використанням інформаційних технологій» 
для студентів ІV та V курсів спеціальності «Переклад» (заочне відділення), було помі-
чено деякі проблеми, що негативно впливали на оволодіння студентами дисципліни, що 
вивчається. 

Враховуючи той факт, що студентам-заочникам виділяється менша кількість го-
дин на аудиторний лекційний матеріал, ми намагалися надати якомога більше інформа-
ції, необхідної для засвоєння дисципліни. Як відомо, традиційною формою проведення 
лекції є надання лектором навчального матеріалу за темою, де викладач задиктовує 
найбільш важливі, з його погляду, аспекти. Обсяг надиктованого залежить як від мате-
ріалу, так і від стилю викладача. Завданням студентів є записати якомога більше інфо-
рмації для подальшого самостійного опрацювання та використання у підготовці до іс-
питу або заліку. У зв’язку з відсутністю літератури з дисципліни або її наявністю в об-
меженій кількості, надто стислим викладенням матеріалу у книжках та наявністю мето-
дичних матеріалів, які є недостатніми для студентів, щоб зрозуміти повною мірою ви-
кладену думку та її підстави, студенти намагаються записати якомога більше з того, 
про що говориться на лекції в аудиторії. Навчальна інформація надається на лекції ли-
ше в односторонньому напрямі – від лектора до аудиторії, при цьому залишається поза 
увагою, на яких аспектах необхідно зупинитись та приділити їм більше уваги, а які по-
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требують лише згадування. При цьому не приймається до уваги, що на даному віково-
му етапі студенти являють собою сформовані особистості, які мають певний особистіс-
ний досвід, світогляд, досвід навчання та сформовані стратегії здобуття знань. Кожен з 
них знаходиться на індивідуальному рівні ментального розвитку, який обумовлений 
особливостями протікання розумових процесів, емоційності, темпераментних власти-
востей, які є наслідком певного психофізіологічного розвитку та виховання. Постає ло-
гічне запитання: чи є матеріал, який надає викладач у лекції достатньо зрозумілим для 
студента. Як правило, студенти соромляться запитувати викладача про незрозумілі ре-
чі, і як наслідок, у підготовці до практичного заняття, заліку або іспиту вони просто 
завчають надану навчальну інформацію для отримання високої оцінки, а оскільки вона 
не підкріплена ґрунтовним розумінням та необхідним розумовим опрацюванням, вона 
забувається одразу ж після контрольного заходу. 

Що стосується практичного заняття, то основною його формою є доповідь, яка 
підготовлена індивідуально на основі опрацьованої літератури або використовуючи на-
явні у мережі Інтернет готові реферати. При цьому студент, користуючись мережею 
Інтернет, обирає перший-ліпший реферат, не розбираючись ані у достовірності джере-
ла, ані у самому матеріалі, тому на практичному занятті він намагається зачитувати 
весь матеріал, не в змозі обрати найбільш важливі та головні аспекти для стислого пе-
реказу. Слухачі в аудиторії після перших хвилин доповіді втрачають інтерес і змогу до 
сприйняття матеріалу, тому часто робота зводиться до того, що студент-доповідач чи-
тає підготовлений матеріал, викладач є уважним слухачем, намагаючись оцінити відпо-
відь, а решта аудиторії складає пасивну масу. Як наслідок, результативність навчання 
від такого заходу є доволі низькою. 

Зробивши аналіз традиційного досвіду викладання у вітчизняних вищих навча-
льних закладах, маючи власний досвід педагогічної діяльності та знаючи усі складнос-
ті, з якими стикаються викладачі і студенти, а також прийнявши до уваги власний до-
свід проведення щорічної студентської конференції „ScienceLooksAhead” в рамках 
„Тижня англійської мови”, власної участі у Всеукраїнських та Міжнародних конферен-
ціях, підготовки доповідей та лекцій, було прийнято рішення трансформувати весь лек-
ційний матеріал дисципліни „Методика викладання іноземної мови з використанням 
інформаційних технологій” у форму презентацій Power Point з їх подальшою демон-
страцією в аудиторії на лекційних заняттях, використовуючи мультимедійний проек-
тор. Дана технологія відпрацьовувалась протягом двох років із навчальними групами 
студентів ІУ-У курсів спеціальності «Переклад» заочної форми навчання факультету 
менеджменту, економіки, соціології та філології Дніпродзержинського державного 
технічного університету. Загальна кількість студентів, що прийняли участь в експери-
ментальному навчанні, становить 25 чол. 

На лекціях ми застосовували комп’ютер і мультимедійний проектор. Коли ми 
трансформували лекції в електронний формат, нам вдалося розв’язати низку методич-
них та психологічних проблем, що виникають у ході традиційної лекції. 

1. Форма презентації Power Point дозволяє представити значно більше теоретичного 
матеріалу, ніж зазвичай опрацьовується на традиційній лекції. 

2. Лекційний матеріал може бути наданий не тільки у формі лінійного тексту, але й 
конденсовано у вигляді схем, таблиць, малюнків, анімації, що дозволяє продемонстру-
вати внутрішні логічні зв’язки між різними аспектами проблеми, що вивчається. 

3. Легкість в оперуванні дозволяє повернутись багаторазово до слайдів, що містять 
найбільш складну для розуміння студентів навчальну інформацію. 

4. Формат презентації Power Point дозволяє викладачу швидко та легко доповнити 
лекційний матеріал, перебудувати його структуру, прилаштувати до потреб певної на-
вчальної аудиторії. 
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5. Студенти обирають власний індивідуальний стиль роботи з навчальним матеріа-
лом для його опрацювання, а саме: 

- користуються допоміжними електронними приборами: фотокамерами, мобіль-
ними телефонами, які оснащені камерами для фотографування слайдів, що демонстру-
ються; у зошит записуються лише індивідуально значуща інформація, як-то відповіді 
на задані студентами питання, уточнення, коментарі, пояснення; 

- роблять окремі нотатки у зошит, після заняття копіюють файл з презентацією на 
власний електронний носій інформації для подальшого опрацювання; 

- конспектують інформацію із слайдів у зошит, маючи змогу занотувати якомога 
більше матеріалу у власний спосіб. 

Маючи навчальну інформацію в електронному форматі у мобільних телефонах, 
ноутбуках, студенти мали змогу звертатись до неї багаторазово, перебуваючи у громад-
ському транспорті, на вулиці та інших місцях, на перший погляд не прилаштованих для 
навчання. Однак можливість багаторазового звернення до матеріалу у невимушених 
обставинах лише сприяла його кращому засвоєнню. 

6. Викладач відчуває більшу впевненість та задоволення від власної праці, оскільки, 
з одного боку, весь необхідний матеріал було представлено, а студенти мали усі мож-
ливості для його опрацювання. 

Працюючи у такому контексті, змінюється парадигма відношень між учасника-
ми навчального процесу. Викладач перестає бути єдиним джерелом знання і навчальної 
інформації. Його функція полягає у спрямуванні інтелектуальної активності студентів 
на певний об’єкт вивчення. 

Звертаючись до інформаційних джерел мережі Інтернет, викладач розширює 
межі пізнання студентів, надаючи їм змогу дослідити дану проблему більш глибоко в 
залежності від індивідуальних інтересів студента завдяки гіпертекстовим зв’язкам тек-
стів та сайтів, представлених у мережі. У такий спосіб фактично реалізується вимога 
навчання та навчальних програм до встановлення міжпредметних зв’язків. Як наслідок, 
студент розглядає та вивчає дисципліну не окремо від усіх інших як ще один компо-
нент навчального плану, а стає свідком того, що предмет вивчення даної дисципліни є 
пов'язаним з іншими, що вивчаються, тим самим укріплюючи предметні та логічні 
зв’язки між інформаційними блоками, глибше розуміючи взаємозв’язок наук і розви-
ваючи суцільне знаннєве утворення, що реалізується у професійній компетентності [2]. 

Маючи вільний доступ до навчальної інформації даної лекції і не турбуючись, 
що її не буде у наявності для подальшого самостійного опрацювання, у студентів виві-
льняється час від постійного пасивного конспектування для спрямування інтелектуаль-
ної активності на освоєння предмету. Таким чином, лекція із традиційного односторон-
нього потоку інформації перетворюється на співпрацю студентів між собою, викладача 
і навчального матеріалу, яка реалізується у формі дискусії, усних доповнень, комента-
рів, привнесенні власного досвіду та знань з боку студентів, що дозволяє скоректувати 
хибні думки та переконання загальними зусиллями [3]. 

Слід зауважити, що для студентів заочної форми навчання у навчальній програ-
мі планується виконання контрольних робіт та подальший їх захист під час проведення 
сесії. Опрацювавши матеріал, який стосувався саме використання електронних засобів 
у проведенні занять з іноземної мови в школі, ми запропонували студентам в якості ви-
конання контрольних робіт підготувати розробки уроків у вигляді презентації Power 
Point з використанням мультимедійного проектора, не обмежуючи себе у засобах ілюс-
тративності та способах надання інформації. Одним із найбільших здобутків такого ви-
ду роботи стало те, що для підготовки презентації студентові необхідно було викорис-
товувати більше ніж одне джерело з наявних книжок чи мережі Інтернет, а це передба-
чало застосування навичок аналізу, синтезу та узагальнення наукової інформації. Треба 
зауважити, що студенти дуже зацікавлено слухали презентації своїх одногрупників, по-
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рівнювали їх, робили цінні зауваження, спираючись на власний досвід викладання в 
школі, обмінювалися джерелами накопиченої інформації і дуже важливим фактом є те, 
що у студентів з’являється мотивація до найкращого виконання завдання, оскільки ви-
сока оцінка одногрупників є досить вагомим для них чинником. До того ж наявність 
ілюстрованих доповідей в електронному вигляді надавала можливість знову і знову пе-
реглядати надану інформацію, зробити необхідні порівняння, встановити логічні 
зв’язки між представленими матеріалами, що сприяло більшому засвоєнню та активіза-
ції пізнавальної діяльності студентів. 

Поряд з цим необхідно зауважити на помилки у впровадженні презентації як фо-
рми подання лекційного матеріалу та, у наступному, доповіді студента. 

Звичка до розташування інформації та навчального матеріалу у вигляді лінійно-
го тексту заважає створенню зручної для сприйняття презентації; інформація повинна 
бути викладена у вигляді стислих положень, системи ключових слів, фраз з наданням 
логічних схем, малюнків, графіків. 

Можливість надання великого обсягу матеріалу у слайдах презентації є споку-
сою для викладача (студента) представити якомога більше інформації, однак її обсяг 
необхідно регламентувати згідно із навчальними здібностями студентської аудиторії і 
реального часу, необхідного для її опрацювання. Завдяки даним двом чинникам презе-
нтація може перетворитись на лінійний документ, що містить надлишкову інформацію, 
викладений мілким шрифтом без виділення ключових слів та положень, що ускладнює 
сприйняття та розуміння матеріалу. Тому для регламентації обсягу та характеру презен-
тації необхідно обговорювати її обсяг (10-15 слайдів) та характер надання інформації [3]. 

Приймаючи до уваги зазначені явища, доцільно встановлювати систему оціню-
вання презентації самими студентами за такими критеріями: 

- за змістом (наскільки тема доповіді відповідає її змісту, повнота та вичерпаність 
інформації); 

- за ілюстративністю (ступінь ілюстративності, наскільки ілюстрації відповідають 
змісту та темі, доцільність використання); 

- за формою (чіткість викладення матеріалу, форми організації матеріалу – схеми, 
таблиці, ін., легкість сприйняття, зрозумілість); 

- творчий підхід (оригінальність оформлення, різноманітність використаних про-
грамних засобів). 

Необхідно також зауважити на особливість, з якою прийшлось стикатись. Не 
зважаючи на те, що студенти до другого курсу вищого навчального закладу вже мали 
достатньо досвіду у роботі з комп’ютерними технологіями, отриманого у контексті ви-
вчення дисципліни „Основи інформатики” у середній школі та вищому навчальному 
закладі, вони стикались з суттєвими труднощами у користуванні комп’ютерною техні-
кою та програмними продуктами, необхідними для підготовки презентації. Даний факт 
ще раз свідчить про необхідність налагодження міжпредметних зв’язків, розширення меж 
навчальної дисципліни та демонстрації можливостей використання отриманих у ході 
вивчення певної дисципліни навичок у інших контекстах та для досягнення інших цілей. 

Окрім того, необхідно також звернути увагу на такий факт, що наскільки творчо 
викладач ставиться до розробки презентацій лекційного матеріалу, настільки творчо 
студенти ставляться до розробки власних презентацій. Ними використовуються ті мож-
ливості програмного забезпечення, які вони бачили у дії під час презентації, що підго-
тував викладач. Лише окремі студенти намагаються урізноманітнити форму подачі ма-
теріалу. 

Наведемо декілька прикладів завдань для роботи з джерелами мережі Інтернет у 
контексті дисципліни «Методика викладання іноземної мови з використанням інфор-
маційних технологій». 

Завдання: 
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1. Розробіть навчально-методичний та роздатковий матеріал для уроку іноземної 
мови (тема уроку та вік учнів на Ваш вибір) у програмі Word. 

2. Створіть три мультимедійні презентації у програмі PowerPoint для використання 
на уроці іноземної мови: 1) на етапі ознайомлення учнів з новим навчальним матеріа-
лом; 2) на етапі активізації та систематизації засвоєного навчального матеріалу; 3) на 
етапі контролю сформованості мовних навичок та мовленнєвих умінь. 

3. Виберіть один із методів викладання, який обговорювався. Розширте ваше понят-
тя про нього, використовуючи Інтернет-ресурси та обміркуйте за і проти його викори-
стання у викладанні мови. 

4. Проаналізуйте Інтернет-сайти, метою яких є навчання англійської лексики (гра-
матики, вимовляння, висловлення, аудіювання, письмо). Підготуйте презентацію, яка 
демонструє їх слабкі та сильні сторони з методологічної точки зору. 

5. Робота у мікрогрупі. Виберіть один із вивчених методів і змоделюйте урок, засно-
ваний на його принципах. Дійте в якості вчителя, а ваші одногрупники будуть учнями. 
Поділіться своїм досвідом у розробці уроку і виконанні ролі вчителя. 

Слід зауважити, що найвища ефективність застосування комп'ютерних інформа-
ційних технологій у мовній підготовці досягається при їх комплексному, системному 
використанні. Цих умов можна дотриматись лише в тому випадку, якщо перекладач не 
тільки досконало володіє рідною й іноземною мовою й глибоко вивчив обрану предме-
тну область, але й упевнено орієнтується в сучасних комп'ютерних технологіях. 

Інформаційне забезпечення складають словники, бази даних і бази знань, реалі-
зовані на компакт-дисках, а також у вигляді розподілених баз. 

Програмне забезпечення складають засоби базового програмного забезпечення 
та пакети прикладних програм ( інформаційно-довідкові й інформаційно-пошукові сис-
теми, програми-перекладачі, експертні системи, навчальні системи тощо). 

При підготовці до практичного заняття студентам дуже часто доводиться корис-
туватися Інтернет-ресурсами, де велика кількість сучасного матеріалу надається в стат-
тях іноземною мовою. І тут на допомогу приходять спеціалізовані програми-перекла-
дачі. Комп'ютерний переклад текстів – одна з найцікавіших і потрібніших інформацій-
них технологій. Комп'ютерний переклад є й однією з найскладніших для програмістів 
задач. Мало хто може похвалитись значними досягненнями в цій галузі. Коли мова йде 
про використання програм для перекладу окремих слів – це для комп'ютера не пробле-
ма: в пам'яті можуть зберігатись десятки словників найбільшого обсягу. Комп'ютерний 
словник викладе всі можливі значення слова, яке потрібно перекласти. Складності по-
чинаються там, де потрібно мати зв'язний переклад великих текстів. 

Велике значення безумовно має якість відповідного програмного забезпечення. 
Ми рекомендуємо студентам користуватися такими програмами-перекладачами, як 
ABBY LINGVA, GOOGLE, PROMT та ін. 

Потужною програмою-перекладачем є програма PROMT Translation Office 2000, 
яка містить набір інструментів для роботи з текстами іноземними мовами. Кожний 
компонент програми (дев'ять компонентів) максимально орієнтований на вирішення 
задач, які можуть виникнути під час роботи з документами, поштовими повідомлення-
ми чи в Internet. Всі компоненти програми об'єднані інтегратором для надання зручного 
доступу до кожного з них. Модулі програми цілеспрямовано орієнтовані на професійне 
вирішення конкретних задач. 

До складу програми входять наступні компоненти: 
PROMT – професійне середовище для перекладу; 
Dictionary Editor – ефективний засіб налаштування словників; 
Electronic Dictionary – електронний словник, інтегрований у PROMT 2000; 
WebView – браузер-перекладач; 
QTrans – експрес-перекладач неформатованого тексту; 
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Clipboard Translator – перекладач буфера обміну; 
Smart Tool – компонент, що реалізує функції перекладу в програмах пакету MS 

Office 2000; 
Mail Translator – оперативний переклад кореспонденції в Outlook 2000. 

Слід зауважити, що технології застосування у навчанні різних електронних сло-
вників та довідників сприяють формуванню у студентів: а) дослідницьких навичок; б) 
зацікавленості у функціонуванні мовної системи як живого організму, що розвивається; 
в) навичок аналізу лінгвістичної інформації; г) критичного оцінювання лінгвістичної 
інформації з метою подальшого застосування у професійних цілях. 

На сьогоднішній день більшість монолінгвальних словників супроводжуються 
CD-диском, який містить усі або деякі з перелічених функцій: 

- можливість пошуку не тільки за алфавітним порядком, але й за іншими показниками; 
- аудіозапис слів у британському та американському варіантах англійської мови; 
- ігри та вправи; 
- інформація про типові помилки; 
- можливість виділяти слово і створювати особистий словник; 
- функції тезаурусу; 
- інформація про частотність використання. 

Такий словник доцільно мати студентам для виконання самостійних домашніх 
завдань, а також встановити його на робочий комп’ютер в навчальній аудиторії для за-
стосування на заняттях. 

Завдання, що пропонуються у межах програми словника, його технічні й мето-
дичні можливості дозоляють викладачу легко інтегрувати даний навчальний засіб у ро-
боту в аудиторії. Основними вимогами до його застосування є: 

а) змістовна вмотивованість; 
б) підбір завдань відповідно до рівня іншомовної підготовки студентів; 
в) часова регламентованість; 
г) забезпечення зв’язку між сформованими лінгвістичними навичками та комуніка-

тивними компетенціями, необхідними для реалізації професійної комунікації. 
Висновки. Підбиваючи підсумки викладеного вище, можна зробити наступні 

висновки: 
1. У контексті викладання теоретичних дисциплін для студентів заочної форми на-

вчання найбільш результативним способами впровадження елементів дистанційної 
освіти є наступні: 
а) підготовка лекцій у формі презентацій, забезпечених зв’язком з мережею Інтернет, 

що дозволяє розширити межі аудиторії та навчального матеріалу через залучення 
інших наукових джерел та інформації; 

б) підготовка студентами доповідей-презентацій як результат самостійного пошуку, ана-
лізу та творчої обробки наукової інформації, що надається джерелами мережі Інтернет. 

Окрім даних видів роботи широкими потенціями до розвитку професійної ком-
петентності студентів шляхом упорядкування їх самостійної роботи є: а) використання 
електронної пошти для розсилки завдань для індивідуального та групового опрацюван-
ня; можливості поставити питання викладачеві стосовно навчального матеріалу або ор-
ганізаційних питань, користуючись можливостями мережі Інтернет; б) взаємообмін ін-
формацією між студентами, сумісне виконання завдання, використовуючи електронну 
пошту, чати та соціальні мережі для встановлення контакту; в) використання програм-
перекладачів для формування дослідницьких навичок, зацікавленості у функціонуванні 
мовної системи як живого організму, що розвивається, навичок аналізу та критичного 
оцінювання лінгвістичної інформації з метою подальшого застосування у професійних 
цілях. 
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2. Такі види роботи сприяють перегляду взаємовідносин учасників навчального 
процесу через зміщення акцентів з особистості викладача як центральної  фігури, єди-
ного джерела і транслятора знань на організацію навчальної діяльності, центрованої на 
особистості студента та його навчальних потребах – на реалізацію особистісноорієнто-
ваного навчання. 

3. Створення можливостей для активного навчання через залучення джерел мережі 
Інтернет сприяє розвитку у студентів ініціативності, відповідальності за свою навчаль-
ну діяльність, вибірковості в професійних та наукових уподобаннях, яка реалізується у 
навичках критично оцінювати інформацію, що пропонується, творчого підходу до ви-
конання професійно обумовлених завдань, розширення світогляду та усвідомлення вла-
сної позиції у суспільно-економічних процесах, що відбуваються. 
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Вступ. Світовий науково-технічний прогрес, інтеграція України в європейський 

освітній простір, комерціалізація промислової діяльності зумовлюють підвищення ви-
мог до володіння випускниками вищих технічних навчальних закладів (ВТНЗ) нормами 
міжкультурної професійно орієнтованої комунікації. Це, в свою чергу, сприятиме по-
доланню мовного бар’єру між представниками вітчизняної та світової технічної еліти, 
налагодженню співпраці та взаємовідносин між людьми та країнами в різних сферах 
діяльності. В основу такого взаєморозуміння, яке сприяє взаємозбагаченню культур, 
має бути покладена іншомовна комунікативна компетентність. 

Постановка задачі. Формування іншомовної комунікативної компетентності 
відбувається через набуті професійні та комунікативні іншомовні компетенції. Ці ком-
петенції мають на увазі наявність необхідних знань, умінь та навиків володіння інозем-
ною мовою, серед яких діалогічне мовлення займає одне із найважливіших місць. Ме-
тою статті є визначення можливості формування іншомовної комунікативної компетен-
тності на прикладі діалогічного мовлення за допомогою Інтернет-ресурсів загального 
користування. 

Результати роботи. З розвитком потреб суспільства змінювались акценти прак-
тичного викладання іноземних мов у ВТНЗ. Формування іншомовної комунікативної 
компетентності стає актуальним питанням для дослідження, що підтверджується пра-
цями Т.Аванесової, Н.Гавриленко, О.Григоренко, B.Зикова, О.Іскандарова, Е.Комарова, 
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Т.Кускова, Н.Кучеренко, Т.Лучкіна, Ю.Маслова, Р.Мільруд, А.Самсонова, Л.Фішкова, 
Л.Халяпіна, І.Цатурова, М.Шишлота та ін. 

Сьогодні у випускників ВТНЗ все частіше виникає необхідність професійного 
спілкування іноземною мовою із закордонними партнерами в різних ситуаціях, що по-
в'язані з роботою спільних підприємств, участю в міжнародних ярмарках, виставках-
продажах, переговорами з представниками іноземних фірм тощо. Кваліфікація майбут-
нього фахівця технічної галузі має розглядатися як синтез його професійної та комуні-
кативної компетенції, спрямованої на формування іншомовної комунікативної компе-
тентності в навчальному процесі. 

У програмі з англійської мови для вищих навчальних закладів зазначено, що 
студентам необхідно набути як професійної компетенції, так і комунікативної іншомо-
вної компетенції. В даному випадку йдеться про набуття необхідних знань, умінь та на-
вичок користування іноземною мовою. Володіння іноземною мовою для досвідченого 
користувача передбачає два рівні. Користувач іноземною мовою першого рівня пови-
нен без утруднень розуміти практично все, що чує або читає. Тобто може отримувати 
інформацію з різних усних чи письмових джерел, узагальнювати та робити її аргумен-
тований виклад у зв'язній формі. Може висловлюватись спонтанно, дуже швидко і точ-
но, диференціюючи найтонші відтінки змісту у досить складних ситуаціях. Користувач 
іноземною мовою другого рівня має розуміти широкий спектр досить складних та об'-
ємних текстів і розпізнавати імпліцитне значення. Може висловлюватись швидко і спо-
нтанно без помітних утруднень, пов'язаних з пошуком засобів вираження. Може ефек-
тивно і гнучко користуватись мовою у суспільному житті, навчанні та у професійній 
діяльності. Може чітко, логічно, детально висловлюватись на складні теми та вести ді-
алог, демонструючи свідоме володіння граматичними структурами, конекторами та 
зв'язними програмами висловлювання [1]. 

У сучасних дослідженнях іншомовну комунікативну компетентність розгляда-
ють як: 

- здатність здійснювати міжкультурне професійно спрямоване спілкування; 
- взаємодію з носіями іншої культури, беручи до уваги національні цінності, норми 

та уявлення; створення позитивного настрою спілкування для комунікантів; 
- вибір комунікативно цілеспрямованих способів вербальної та невербальної пове-

дінки на основі знань про науку і культуру інших народів у межах полілогу культур; 
- результат затрачених зусиль, спрямованих на формування таких іншомовних 

знань і вмінь, які відображають лінгвістичний, професійно-контекстуальний, психоло-
гічний, соціальний та ситуативний стан мови як засобу професійного спілкування; 

- здатність, сформовану в процесі навчання іноземної мови, вільно і адекватно до 
умов соціально-рольових ситуацій професійної діяльності розуміти й зумовлювати від-
повідні мовленнєві висловлювання згідно з теоретичними положеннями і знаннями, що 
виконують інформаційно-комунікативну функцію, а також практичні вміння та навич-
ки, які забезпечують перцептивно-комунікативну та інтеракційно-комунікативну функ-
ції спілкування за допомогою засобів іноземної мови; 

- володіння індивідом необхідним рівнем знань, умінь і навичок, що визначають сту-
пінь сформованості його професійної діяльності, стилю професійного спілкування та йо-
го особистості як носія визначених цінностей, ідеалів і професійної свідомості [2, с. 8]. 

Отже, іншомовна комунікативна компетентність є інтегральною характеристи-
кою професійної діяльності фахівця і забезпечує компетентне професійне спілкування в 
умовах міжкультурної комунікації. 

Оволодіння іншомовною компетентністю передбачає сформованість комуніка-
тивних умінь у чотирьох основних видах мовленнєвої діяльності (говоріння, аудіюван-
ня, читання, письмо), наявність мовних знань (фонетичних, граматичних, лексичних) та 
навичок оперування ними. 
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Говоріння як вид мовленнєвої діяльності існує у діалогічній і монологічній фор-
мах. Діалогічне мовлення значно переважає, оскільки у повсякденному спілкуванні лю-
ди користуються діалогом [3]. 

Відпрацювання діалогічних вмінь є одним з найбільш важливих методичних ас-
пектів в навчанні усному мовленню на іноземній мові. 

Як відомо, діалог займає практично 70% нашої розмовної мови і при вивченні 
іноземної мови є одним з невід'ємних компонентів навчання. 

Згідно із робочими програмами з англійської мови для студентів технічного на-
пряму майбутні фахівці повинні вміти: 

- розуміти діалоги за змістом загальнотехнічного тексту; 
- будувати діалоги за змістом загальнотехнічного тексту та озвучувати їх; 
- складати діалоги у сфері особистої та повсякденної діяльності [4]. 

Діалогічне мовлення – це процес взаємодії двох або більше учасників спілку-
вання. Тому в межах мовленнєвого акту кожен з учасників по черзі виступає як слухач і 
як мовець. Діалогічне мовлення передбачає мовленнєву взаємодію двох і більше спів-
розмовників, кожен з яких по черзі є то мовцем, то хто слухачем. Мета навчання студе-
нтів діалогічній формі спілкування полягає у формуванні у них навичок ведення бесіди 
один з одним у ході заняття, а також з носіями мови. Випускник технічного ВНЗ, на-
вчений діалогічному спілкуванню, повинен володіти цим типом мовлення на комуніка-
тивно достатньому рівні, що забезпечує вживання вивченого мовного і мовленнєвого 
матеріалу в нових ситуаціях спілкування відповідно до поставленої мети, комунікатив-
них намірів. Як правило, діалогічна мова спонтанна і не може бути спланована заздале-
гідь. Діалогічне спілкування представляє собою процес спільного мовотворення, в яко-
му мовна поведінка учасників визначається мовною поведінкою їх співрозмовників. У 
цьому і полягає його основна відмінність від монологу. Саме тому діалогічна мова пред-
ставляє для студентів технічного вузу набагато більше труднощів, ніж монологічна. 

Сформованість вмінь діалогічної мови студентів означає наявність в них ряду 
вмінь, які забезпечують виконання поставленої комунікативної задачі в типових умовах 
спілкування. Можна виділити наступні вміння діалогічної мови. 

Стимулювання співрозмовника на висловлювання. Дане вміння включає в себе 
вміння запитувати думку партнера, уточнюючи цікаву інформацію; запитувати і пові-
домляти фактичну інформацію, переходячи з позиції того, хто питає на позицію того, 
хто відповідає. Стимулом може бути: питання, твердження, прохання, пропозиція і т.д. 

Реагування на мовний стимул. Репліка-стимул і репліка-реакція складають діа-
логічну єдність. Сформованість даного вміння є здатність висловити згоду/незгоду з 
пропозицією партнера, зробити пропозицію згідно з ситуацією і темою спілкування, 
погодитись/не погодитись з твердженням партнера, вибачитись, висловити емоційну 
оцінку різного характеру (радість/сум/сумнів/подив і т.д.). 

Розгортання репліки-відповіді. Сформованість даного вміння передбачає здат-
ність студентів підтримувати розмову, тобто при відповіді висловити і аргументувати 
свою точку зору, дати пораду і прийняти/не прийняти пораду партнера, ввічливо запи-
тати знову в разі необхідності [5]. 

Отже, говорячи про таку важливу проблему, як навчання діалогічному мовлен-
ню студентів технічного ВТНЗ, не можна не зазначити, що навчання даному виду мов-
леннєвої діяльності є досить складним процесом. Завдання викладача в цьому процесі 
полягає у відпрацюванні діалогічних навиків і організації навчання таким чином, щоб 
після закінчення ВНЗ випускники володіли навиками діалогічної мови на рівні, достат-
ньому для здійснення спілкування в їх професійній діяльності. 

Через брак навчального навантаження кількість годин, що відводяться на прак-
тичні заняття протягом курсу вивчення англійської мови, скорочується. Дуже часто ви-
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кладачу на вистачає часу на перевірку у студентів навиків діалогічного мовлення саме 
під час аудиторних занять і тому доводиться лишати багато матеріалу на самостійне 
опрацювання. Викладач повинен слідкувати за лексичним і граматичним наповненням 
діалогів. В цій ситуації можуть стати у нагоді Інтернет-ресурси загального користування. 

Останнім часом широкого використання набуло впровадження в освітній процес 
методів навчання із використанням Інтернет-ресурсів. Ці методи використовують як спеці-
алізовані програми, інформаційні портали, так і Інтернет-ресурси загального користування. 

Використання соціальних мереж загального використання набуло широкого по-
ширення, оскільки вони надають можливості обміну інформацією в широкому плані 
(аудіо-матеріали, відео-матеріли, текстові документи в різних форматах), можливість 
інтерактивного спілкування, а також є найбільш прогресуючим та адаптивним до по-
треб користувачів. До переваг соцмереж відносяться: відсутність потреби у спеціаль-
ному програмному забезпеченні, навиків по його установці, налагодженню, викорис-
танню; загальнодоступність і легкість при використанні; широкий вибір можливостей 
для організації виду та типу спілкування (надсилання повідомлень, участь у групах); 
легкий доступ до текстової, аудіо- та відеоінформації. 

Використання соціальних мереж може бути у нагоді наступним чином. Викла-
дач, маючи власну сторінку, наприклад, у MySpace [6], Bebo [7], Facebook [8], Tagworld 
[9], має можливість використовувати їх ресурси з великою користю. Оскільки нами до-
сліджується проблема формування діалогічних навиків, то увага буде звернена на мож-
ливість відтворення аудіо-запису. Викладачу може не вистачати часу на перевірку діа-
логічного мовлення на практичних заняттях. Студент, виконуючи завдання в рамках 
самостійної роботи, має можливість прикріпленим файлом надіслати на сторінку ви-
кладача аудіо-запис із своїм діалогічним мовленням. Викладач, у свою чергу, має до-
статньо часу на прослуховування матеріалу, знаходження помилок, складання заува-
жень до цієї роботи. На практичних же заняттях викладач опрацьовує із студентами за-
уваження, не витрачаючи часу на прослуховування діалогу. Вміння молоді користува-
тися інформаційними технологіями не викликає труднощів налагодити зв’язок із ви-
кладачем у такий інтерактивний спосіб. Застосування такого роду роботи над діалогіч-
ним мовленням несе позитивний вплив на його формування та розвиток, спонукаючи 
викладача стати на один технічний щабель зі студентами. 

Висновки. В кінцевому результаті сформоване діалогічне мовлення позитивно 
впливає на іншомовну комунікативну компетентність майбутніх фахівців технічного 
профілю у міжкультурній комунікації. Використання Інтернет-ресурсів загального ко-
ристування надає викладачам і студентам додаткові можливості і час у формуванні діа-
логічних навиків, потрібних для формування іншомовної комунікативної компетентно-
сті. Інтернет-ресурси загального користування виявляються ефективними у вирішенні 
зазначеного питання. 
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ПОВЫШЕНИЕ ЭФФЕКТИВНОСТИ ПОДГОТОВКИ СТУДЕНТОВ  

НА ПРАКТИЧЕСКИХ ЗАНЯТИЯХ  
ПО КУРСУ «СОПРОТИВЛЕНИЕ МАТЕРИАЛОВ» 

 
Введение. Проблемы подготовки квалифицированных инженерных специалистов 

в Украине в настоящее время приобретают все большую актуальность. И в первую оче-
редь это касается преподавания механических дисциплин в украинской высшей школе. 
Сегодня при подготовке специалистов как механического, так и смежных инженерных 
направлений в ВУЗах Украины вопросам качественного обучения механическим дис-
циплинам уделяется недостаточно внимания. И в первую очередь это касается препода-
вания такой ключевой дисциплины, как «Сопротивление материалов», а также прочих 
дисциплин, для которых «Сопротивление материалов» является основной составляю-
щей, например, таких курсов, как «Техническая механика» и «Прикладная механика». 

Конечно же, эффективность будущей профессиональной деятельности студентов 
во многом зависит от характера и организации учебной деятельности – управляемого 
процесса взаимодействия преподавателей и студентов, направленного на приобретение 
знаний, умений и навыков, способности к самообучению и приобретению мировоззрения. 

В настоящее время преподавателям всех общетехнических наук предстоит решить 
проблему активизации познавательной активности студентов в условиях сокращения 
часов аудиторных занятий. Не стоит забывать, что специфика преподавания курса «Со-
противление материалов» связана с тем, что формирование понятий курса основано на 
знаниях, полученных студентами при предварительном изучении четырех фундамен-
тальных курсов – физики, теоретической механики, математики и материаловедения. 

Постановка задачи. Интеграция теоретических знаний по указанным курсам и 
практическое применение их в отношении поставленных в курсе «Сопротивление ма-
териалов» задач сопровождается большими затруднениями, так как прочные знания и 
умения по всем четырем базовым дисциплинам в совокупности у большей части сту-
дентов отсутствуют. 

Студент, даже хорошо понимающий физику явления, происходящего при раз-
личных деформациях конструкции, часто не владеет математическим аппаратом, по-
зволяющим не только качественно оценить прочность конструкции, но и произвести 
точный и правильный расчет, а также количественную оценку прочности. 

Часто встречается ситуация, когда студент хорошо владеет математическим ап-
паратом, свободно и точно выполняет расчет, не понимая, что происходит с конструк-
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цией в том или ином напряженно-деформированном состоянии. К сожалению, наибо-
лее часто встречается такая ситуация, когда студент не понимает и физику явления, и 
не способен принять самостоятельного решения по формированию последовательности 
расчета и не может выполнить его. Поэтому студенты технического университета, изу-
чающие курс «Сопротивление материалов», испытывают трудности не только в интел-
лектуальном, но и в психологическом плане. 

Традиционный способ проведения занятий по курсу «Сопротивление материа-
лов» рассчитан на такую категорию студентов, которые способны выполнять расчет 
только по образцу. С одной стороны, такой подход создает условия для того, чтобы во-
влечь в учебный процесс всех студентов, даже тех, кто не способен к самостоятельному 
мышлению. 

Но с другой стороны, при таком подходе не происходит развития продуктивного 
мышления учащихся, то есть одна из важнейших целей образовательного процесса не 
достигается. 

Проведение практических занятий по курсу «Сопротивление материалов» тра-
диционным способом построено так, что решение каждой задачи является для студента 
как бы особой проблемой, в ходе решения которой он сталкивается со специфичным 
набором условий. Учет этих условий сопровождается изучением большого числа пра-
вил и рекомендаций, носящих частный характер. При решении следующей задачи на-
бор условий, правил и рекомендаций существенно отличается от предыдущего. 

Для студентов, не обладающих самостоятельным, продуктивным мышлением, 
возникает проблема запоминания набора правил, которые они не в состоянии диффе-
ренцировать и относить ко всему спектру задач. При этом содержательная область 
предмета (оценка напряженно-деформированного состояния) остается недоступной для 
понимания, так как все усилия студент тратит на заучивание правил и обозначений, со-
ставляющих вспомогательную часть в решении задач. 

Анализируя создавшуюся ситуацию, можно прийти к выводу о том, что необхо-
димо изменить методику проведения практических занятий так, чтобы на первое место 
поставить главную задачу по формированию у студентов понимания и освоения сущ-
ности предмета, а запоминание и освоение правил и методик расчета подчинить глав-
ной задаче. 

Результаты работы. Для решения поставленной задачи необходимо так изме-
нить методику проведения практических занятий, чтобы научить студента: 

- выделять главное в теоретическом материале, что непосредственно относится к 
области решения задач по изучаемой теме (например, определение опасного сечения 
при растяжении стержня); 

- самостоятельно анализировать постановку задачи; 
- выделять общие для всех задач этого класса этапы выполнения расчета; 
- классифицировать обозначения, правила знаков, правила построения эпюр для за-

дач данного класса; 
- освоить основные этапы решения задачи; 
- выделять отличия в постановке следующей задачи и определять, на каком этапе 

решения задачи возникнут изменения в расчете; 
- анализировать все частные случаи решения одного класса задач; 
- варьировать условиями задачи и корректировать план решения задачи в зависи-

мости от совокупности начальных условий. 
При переходе к решению задач другого класса (например, определение опасного 

сечения при кручении) следует проводить занятие, опираясь на материал, изученный в 
предыдущей теме: 

- найти общее и различное в теории предыдущей и изучаемой темы; 
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- подчеркнуть отличия в обозначениях, правилах знаков и построения эпюр; 
- предусмотреть упражнения на выделение общего и различного в задачах преды-

дущей и изучаемой темы. 
Приведу пример схемы ориентировочной основы деятельности на занятии по 

теме «Расчет стержня при растяжении-сжатии». 
Цели занятия. 

1. Изучить понятия: 
- деформация растяжения-сжатия; 
- внешние усилия, вызывающие деформацию; 
- внутренние силовые факторы (ВСФ), возникающие при растяжении-сжатии; 
- опасное сечение при растяжении-сжатии. 

2. Изучить методы: 
- метод построения эпюр при растяжении-сжатии (метод сечений). 

3. Изучить правила и обозначения: 
- обозначения внешних нагрузок при растяжении-сжатии; 
- обозначение ВСФ при растяжении-сжатии; 
- правило знаков ВСФ для уравнений по методу сечений; 
- правило построения эпюр при растяжении-сжатии; 
- правило определения опасного сечения по эпюрам ВСФ при растяжении-сжатии. 

4. Научить студента самостоятельно выполнять действия: 
- задавать силовые участки; 
- записывать уравнения статического равновесия на силовых участках (по мето-

ду сечений); 
- строить эпюры ВСФ и определять опасное сечение. 

5. Научить студента варьировать условия задачи (изменять направление, величину 
и точку приложения внешних усилий) и выполнять корректировку в выполнения расче-
та решенной задачи. 

Согласно теории П.Я.Гальперина каждый вид действия в общей структуре дея-
тельности обладает специфической функцией и структурой. П.Я.Гальперин выделяет в 
любом действии, независимо от уровня его выполнения, две части: ориентировочную и 
исполнительную, придавая большое значение характеру ориентировки в содержании и 
структуре учебного материала [1]. 

В.П.Беспалько отмечает важное значение ориентировочных действий в общей 
структуре учебной деятельности: «Ориентировочными действиями определяется ра-
зумность и правильность выполняемой деятельности, а также быстрота включения в 
работу» [2, с.71]. 

Под ориентировочной деятельностью мы понимаем деятельность, направленную 
на получение знаний о характере и условиях предстоящей деятельности, осознание по-
ставленной задачи и создание схемы ориентировочной основы деятельности. 

В нашем примере выделим ориентировочную и исполнительную деятельность. 
К ориентировочной деятельности относится достижение первых трех целей: это 

изучение основных понятий по теме, изучение метода расчета и изучение правил и обо-
значений. Здесь очень важным является соблюдение иерархии целей. 

Так, если мы понадеемся на знания студента, полученные из прочитанной по те-
ме лекции, и опустим первую цель (изучение основных понятий по теме), то большин-
ство студентов будет воспринимать новую тему как нечто обособленное от общего со-
держания предмета. В этом случае изучение методов и правил построения эпюр не по-
служит формированию ориентировки в решении задач данного класса и не приведет к 
продуктивной исполнительной деятельности, а будет нацеливать студента на репродук-
тивную исполнительную деятельность – решение по образцу. 
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Причем уже в процессе достижения первой цели занятия необходимо дать ори-
ентировочную схему действий по решению задач новой изучаемой темы. Последова-
тельность изложения материала может быть такой. 

1. Повторить понятие рассматриваемой деформации. 
2. Выяснить, что происходит со стержнем при деформации растяжения-сжатия на 

наглядном примере (демонстрация дидактического учебного пособия). 
3. Выяснить, как должны быть направлены усилия, вызывающие деформацию рас-

тяжения-сжатия. 
4. Повторить понятия ВСФ и выяснить, какие ВСФ возникают именно при дефор-

мации растяжения-сжатия. 
5. Дать понятия эпюр ВСФ как графического отображения распределения ВСФ по 

длине стержня. Сказать о характере математических функций, описывающих деформа-
цию растяжения-сжатия (функций постоянного значения от сосредоточенных нагрузок 
и функций, меняющихся по линейному закону, от нагрузок, распределенных по длине 
стержня.) 

6. Дать понятия опасного сечения. 
Это можно назвать первым этапом ориентировки, в процессе которого студент 

изучает ряд основных понятий по новой теме и одновременно узнает, где и с какой це-
лью он будет использовать эти понятия при решении практической задачи. Так ориен-
тировочная деятельность формирует мотивацию к углубленному изучению понятий с 
целью их практического применения для достижения уже осознанного студентом 
предполагаемого результата. 

На втором этапе ориентировочной деятельности необходимо заинтересовать 
студента вопросом, каким образом, без проведения испытаний, а только с помощью ма-
тематического аппарата можно точно определить место вероятного разрушения стерж-
ня, находящегося под нагрузкой. 

Последовательность проведения занятия на этом этапе может быть такой. 
1. Поставить задачу: как можно определить место возможного разрушения стерж-

ня, находящегося под нагрузкой (опасное сечение), и после обсуждения предложить 
рассмотреть метод сечений. 

2. Выполнить пример применения метода сечений и научить записывать выраже-
ния статического равновесия стержня, известные студентам из курса теоретической ме-
ханики, в соответствии с требованиями метода сечений: в левой части – обозначение 
ВСФ, в правой части – сумма всех внешних усилий. Дать обзор и обозначение нагру-
зок, вызывающих деформацию растяжения-сжатия, дать обозначение ВСФ, соответст-
вующее деформации растяжения-сжатия. 

3. Задать вопрос, а как изменится записанное выражение, если внешние усилия бу-
дут вызывать деформацию кручения, изгиба? 

4. Дать понятие о правилах знаков, установленных по методу сечений, как о согла-
шениях, которые должны привести к унификации в написании уравнений. Подчеркнуть, 
что эти правила знаков связаны с деформацией, которую вызывают внешние усилия, а 
не с направлением усилий, как это было в курсах физики и теоретической механики. 

5. Дать правила знаков для записи уравнений по методу сечений для деформации 
растяжения-сжатия. 

В любом случае при грамотном подходе преподавателя к работе на первых двух 
этапах ориентировочной деятельности необходимо работать с аудиторией, задавать во-
просы, проводить дискуссии. 

На третьем этапе ориентировочной деятельности необходимо установить общее 
правило построения эпюр ВСФ (характер эпюр, положительные, отрицательные облас-
ти эпюр, типы линий и обозначения). 
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1. Построить эпюру от сосредоточенной силы на одном силовом участке стержня. 
2. Построить эпюру от распределенной нагрузки на ином силовом участке стержня. 
3. Сравнить полученные результаты. Выяснить, как изменится эпюра, если изме-

нить знак одного из приложенных усилий. 
4. Научить определять опасное и равноопасные сечения стержня. 

Итак, в ходе трех этапов ориентировочной деятельности, студент осваивает не 
только процесс решения данной задачи, используя большой набор приемов и правил, 
но осознает глубину поставленной задачи в рамках оценки прочности конструкции и 
воспринимает использование математического аппарата не как самоцель, а как средст-
во для решения проблем прочности конструкций. 

Теперь исполнительная деятельность студента, основанная на стремлении его к 
продуктивному мышлению, будет осознанной, мотивированной, развивающей и само-
стоятельной. 

Исполнительная деятельность студентов подразделяется на два этапа. На первом 
этапе предлагается студентам решить еще один пример совместно с преподавателем на 
доске, по желанию студенты выходят к доске и выполняют отдельные пункты решения 
задачи. Задача должна содержать более сложное сочетание внешних нагрузок. На вто-
ром этапе исполнительной деятельности студентам дается пример для самостоятельно-
го решения. Те студенты, которые не уверены в себе, могут пользоваться помощью 
преподавателя. Более сильные студенты, самостоятельно решающие задачу, имеют 
право получить большие баллы, если предъявят не только правильное решение, но и 
правильное оформление задачи. Три студента, первыми решившие этот пример, могут 
рассчитывать на наивысшие оценки в группе, тем самым закрыв вопрос сдачи данной 
темы во время проведения зачета или экзамена. Таким образом, будет производиться 
мотивация студентов к более продуктивной и целенаправленной образовательной дея-
тельности. 

Выводы. Итак, используя элементы теории ориентировочной деятельности на 
практических занятиях по курсу «Сопротивление материалов» со студентами техниче-
ских университетов, можно добиться повышения мотивации к изучению предмета, а 
значит возрастания познавательной активности студентов, что приведет к развитию 
продуктивного мышления и приобретению навыков самостоятельного выполнения рас-
четов по оценке прочности, жесткости и устойчивости элементов конструкций. 

Конечно же, в условиях сокращения количества аудиторных занятий для курсов 
«Теоретическая механика», «Сопротивление материалов», «Техническая механика», 
«Прикладная механика», как, впрочем, и иных инженерных дисциплин, читаемых в 
ВУЗах Украины, добиться поставленной цели непросто. Однако при правильном пони-
мании сути метода поэтапного формирования умственных действий, при надлежащей 
подготовке к практическим занятиям и достаточной педагогической квалификации 
грамотный преподаватель вполне успешно может осуществить предложенную в статье 
методику организации и проведения занятий. 
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